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Introduction
Welcome to the Command Ops 2 (CO2) Estab Editor. The Estab Editor is used to create and modify 
CO2 estabs. You can also use it to access data about the estab objects - forces, weapons, vehicles, 
ammo etc. 

Estabs are generated in a two step process. First you edit an estab.xml file in the Estab Editor. Then 
you compile the estab.xml file into a binary estabs.coe file that is used by the Cmd Ops Game and 
ScenMaker apps. The .xml file is compiled by a separate app called the Estab Manager. You can initiate 
the compile from within the Estab Editor. It will open the Estab Manager in the background, run the 
compile and close the Estab Manager automaticaqlly. Alternatively, you can run the Estab Manager 
directly. 

The Estab Editor is a standard Windows type application with a menu bar at the top. This includes the 
standard File menu that allows you to open, close, create new estab.xml files, save and save as existing 
estab.xml files. 

This manual is organised along functional lines and in a sequence that most users will employ when 
creating/editing the estabs. If you want to know how to do a specific thing, look up the table of 
contents.

What’s in this Manual

This manual is organised in two parts – the Basics and the Guide. The Basics provides an overview 
of the user interface. The Guide walks you through the steps for creating and modifying estabs. If you 
want to know how to do a specific thing, look up the table of contents. 

What Makes an Estab

An Estab contains common or generic data used by a class of entities. Eg an EstabForce, such as a US 
Inf Company contains the data common to all units of that type. There are four broad Estab classes:

Forces – These comprise Side, Nation, Service and Force ( or Unit ).

Equipment - These comprise Vehicles and Weapons.

Ammo - Eg 81mm mortar High Explosive, 9mm ball.

Formations – These control the parameters and effects of the various formation types - eg road 
column, line, arrowhead etc.
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The Basics

Estab Files ( IMPORTANT )
As mentioned above, there are two typers of estab files - the  raw.xml and the compiled .coe files. 
When you create a scenario in the ScenMaker you link a specific .coe file to it. There can only be one 
estab.coe file per scenario. So, while you can create a new estab file from scratch, it is recommended 
instead that you clone the existing CO Estab.xml file and edit it - ie. load the exisitng .xml file and do 
a SaveAs, naming it something different. That way you will start with all the pre-existing estab data, 
rather than having to reinvent the wheel. 

Further, it is strongly recommended that you do not edit existing data objects, but instead clone them 
and edit the clones. That way your modified estab file can still be used to run the standard scenarios. 
Stricktly speaking, this is is not essential so long as you retain the original CO Estabs file. However, it 
is recommended practice.

Aslo in the ScenMaker application you can migrate the estab file being used by a scenario to another 
estab file. See the ScenMaker Manual for more details.

Getting Started
First things first. 

Launch EstabEditor

To launch the EstabEditor application:

	 Select the EstabEditor program from the Start\Programs\Battles from the Bulge menu or

	 Double-click the EstabEditor application icon in the game directory

Open Estab.xml file

To open an Estab.xml file:

	 Select Open from the File menu
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This will open the Open window 
displaying a list of map files within the 
Map directory, which is part of the Game 
directory.

	 Select the desired .xml file from 
the list

	 Click on the Open button

Save Estab.xml file

To save an Estab.xml file under the same name:

	 Select Save from the File menu

To save the Estab.xml file under a different name:

	 Select Save As… from the File menu

IMPORTANT make sure that the new Estab.xml file is saved under the 
CO|Estabs directory. Otherwise it won’t be accessible to the CmdOps game 
app.
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This will open the Save As 
window displaying a list of 
estab files within the Estabs 
directory.

	 Enter the desired 
name

	 Click on the Save 
button

Note avoid saving over 
the top of the original CO 
Estabs.xml file provided. It 
is recommended that after 
opening this file, you do a 
Save As and give it a different 
name before modifying it.

Close Estab.xml file

To close an Estab.xml file:

	 Select Close from the File menu or

	 Click on the Close Box at the top right of the 
EstabEditor window

Create a New Estab.xml file

To create a new Estab.xml file:

	 Select New from the File menu 

WARNING - IMPORTANT - Creating a new Estab.xml file is not recommended. 
Instead clone an existing Estab.xml file. See Estab Files above. 
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The User Interface – A Quick Tour
With an Estab.xml file open, the main screen displays a menu bar at the top, a sidebar on the left and 
a workspace on the right into which various data windows are opened. The sidebar comprises a set of 
class tabs used to change the content of the item list.

The Weapons, Ammo, Vehicles and Formation listings are simple lists with a series of items one after 
another. The Forces listing is a tree list starting with the Side estabs, under which are nested the Nation 
etsabs, under which are the Service estabs, under which are the individual force or unit estabs.

Open

To open the data window for a particular item:

	 Double-click the item in the list or

	 Right click and select Open from the context menu.              
( Does not apply to formation items. )
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Expand/Collapse

To expand/collapse a node in the Forces tree list:

	 Click on the +/- box to the left of the node.

Delete

To delete an item from the list:

	 Right click and select Delete from the context menu or

	 Hit the Delete Weapon/Ammo/Vehicle button in the 
toolbar below the tabs. 

Duplicate

To duplicate an item from the list:

	 Right click and select 
Delete from the 
context menu.

This will open a new data 
window for the item duplicating 
all the data from the original 
item and prefixing the name 
with “Copy of”. 

	 Rename.

	 Edit the data

	 Hit OK.
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New

To create a new weapon, ammo or vehicle item:

	 Right click and select Insert New item Above from the 
context menu or

	 Hit the New Weapon/Ammo/Vehicle button in the toolbar 
below the tabs. 

This will insert a new item 
in the list above the one 
you selected and open a 
new data window with a 
default name.

	 Rename.

	 Edit the data

	 Hit OK.

To create a new side, nation, service or force: 

	 Right click the parent and select Insert New item from the 
context menu. 

Eg. to create a new unit for the German Army, select the German 
Army service ( ie Heer ). 
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This will insert a new 
item in the list below the 
last child of the parent 
you selected and open a 
new data window with a 
default name.

	 Rename.

	 Edit the data

	 Hit OK.

Note you cannot create new formations, only edit existing ones. These are hard coded into the Game. 

Ranks

To add a new rank to a Service:

	 Hit the Add button and enter the 
desired Full Name and Short Name

To edit a rank to a Service:

	 Select the desired entry in the list 
and re-enter the desired Full Name 
and Short Name

To delete a rank to a Service:

	 Select the desired entry in the list 
and hit the Remove button.
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Colors

To set the colors of the default icon for a Service	:

	 Select the desired Symbol Color - either black or white.

	 Click on a color bar to open the color picker screen

	 Either click on a basic color patch, a custom color patch, the colour spectrum or specify the RGB 
or HSL values

	 Hit OK
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Find

To find the force estabs that use the selected weapon, ammo or 
vehicle:

	 Right click and select Find Estabs Using Weapon/Ammo/
Vehicle from the context menu. 

This will open a listing of the 
found force estabs.

	 Double-click an item in the 
list to open its data view. 

To find an estab containing a specified text:

	 Select the Find Estabs By Text item from the Tools menu. 

This opens the search window.

	 Enter the desired text in the Search for Estabs Containing 
field. 

	 Hit the Find button. 

This searches all estab classes and populates the list with any estabs 
that contain the text either in any of their fields.

	 Double-click an item in the list to open its data view. 
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Sort

To sort the Weapon/Ammo/Vehicle lists alphabetically:

	 Check the Sorted box below the tabs. 

To sort the Weapon/Ammo/Vehicle lists by order of entry:

	 Uncheck the Sorted box below the tabs. 

To sort the force estabs by HQ and alphabetically:

	 Check the Sort Forces by HQ/Name box. 

To sort the force estabs by order of entry:

	 Uncheck the Sort Forces by HQ/Name box. 
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Menus

The menu bar is at the top of the window and consists of the following menus.

File

Provides standard Windows application File menu features – New, Open, Close, 
Save, Save As, recent files and Exit. 

Build

The Build menu has items to Compile Estab File and Run Estab Manager. 

Compile Estab File compiles the estab.xml file into the binary .coe file that 
the Cmd Ops game app uses. It does this by launching the Estab Manager 
app in the background and closing it automatically once it has completed the compile. 

Run Estab Manager opens the Estab Manager application. This is a stand alone app whose prime 
function is to compile the estab .xml file into the binary .coe file used by the Cmd Ops game app. It can 
also import/export .xml files to and from the .coe file. This is a tool that you don’t need to use directly. 
Instead you can simply use the Compile Estab File menu item.

Tools

Provides the Find Estabs by Text item, which opens a find window, and the 
Export... and Import... item which allow you to export and import Weapon 
Performance data to and from a spreadsheet file.
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Data View Menu

Each of the Data Views has a menu. To access it:

	 Click on the Menu icon
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Entering Data
All data views have a Menu icon - see Data View Menu - an OK, Cancel and Apply buttons. The OK 
button saves and closes the view. The cancel closes the view without saving and changes and the Apply 
saves without closing.

Name - All estab items have a Name. While you can 
use whatever name you like we recommend you keep 
them concise and follow the naming conventions where 
mentioned. If nothing is mentioned then refer to previous or 
existing entries for guidance.

Description - Ammo, Weapon and Vehicle estabs have a 
Description field. Here you can ad lib with whatever you 
like. This will appear in the description field of the estab data 
views in the game. It does not have any direct effect on the game mechanics. Rather its purpose is to 
inform the user. 

Note that not all data fields appear in the estab views of the game. However, they are still important.

If you do not have a reliable source for the data, then use a similar existing entry as a guide.

Note that decimal values may be rounded or adjusted by the program. Eg entering 1.0 may end up 
being displayed as 1.000123. Don’t worry if minor adjustments to the value are made like this. It’s all 
good.

We are going to start with the basic elements first - ie ammo. Then we’ll work our way up addressing 
weapons, vehicles, forces and formations.

Estab Images
Weapons and Vehicles can use an Estab Image file as a representation within the game. These must be 
in the .bmp format and measure no more than 100 x 60 pixels. Each image must be stored in its own 
file using the naming convention: “Estab_Image_#####.bmp”. Eg “Estab_Image_03182.bmp”. Each 
must have a unique file name. It is recommended these are numbered in sequence. 

Each Estab file must have its own Estab Images directory containing all the image files. The images 
directory must be named the same as the .xml file but appending “_Images”. Eg If you save the .xml 
file as “MyEstabs.xml” then you must save the images directory as “MyEstabs_Images”. 

Make sure that the associated images directory is located under the CO\Estabs directory.

When you clone the original COEstab.xml file, also clone the COEstab_Images folder.
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Ammo
Apart from the Name and Description there are just two 
fields. 

Minimum Order Quantity - The minimum number of 
rounds that can be delivered when resupplying. Effectively 
and amount requested is rounded up to this figure.

Weight - The weight in kilos of the Minimum Order 
Quantity.

Weapons

General Tab

Type - Choose from the 
drop down menu.

Primary Role - Choose 
from the drop down menu.

Single Shot - Check if 
this weapon is used up 
after firing - eg single shot 
rocket launchers like a 
panzerfaust.

Must Deploy to Fire - 
Check for all weapons 
that need to spend time 
deploying before they can 
fire. Eg. Hvy machine 
guns, AT weapons, mortars, 
artillery.

Width/Height/Length and Weight - the dimensions in metres and weight in kilos.

Picture - The ID of the Estab Image file located within the associated Estab Images folder - see Estab 
Images above.

No Image - Check if there is no image file for this weapon.
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Performance Tab

Calibre - the inside 
diameter of the barrel in 
millimetres.

Muzzle Velocity - how 
fast the round is moving 
on leaving the barrel in 
metres per second.

Crew - how many 
personnel  that normally 
operate the weapon.

Reliability - a percentage 
measure of how 
mechanically reliable the 
weapon is, where 1.00 = 
100%. This value affects 
the probability of the 
weapon firing at any given 
fire event. 

Fire Types - Check the different fire types if the weapon is normally used for this type of fire. aair = 
anti aircraft, aarm = anti armour, aper = anti personnel, bombard = indirect area fire. Note that smoke 
is currently not modelled, so leave unchecked.

To edit the data for a given 
fire type:

	 Select the fire type 
from the list.

This will change the name 
in the performance group - 
eg to bombard.
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Ammo - The Ammo estab 
used by this weapon for this 
fire type. To set the Ammo 
estab:

	 Drag the desired 
Ammo estab item 
from the Ammo tab 
list onto the Ammo 
field and release.

Load - The number of rounds stored at the weapon.

Min Range - The minimum distance in metres that the target must be from the weapon.

Rates of Fire - The number of rounds fired per minute at Slow, Normal and Rapid rates of fire. Please 
note that these are practical rates of fire not cyclical or theoretical rates of fire.

Burst Radius - The range in metres out to which significant fragments or shrapnel or blast occurs. 
Don’t use safety blast ranges as these are significantly greater.

Shell Weight - The weight of the shell in kilos. This value is used to determine hit and kill 
probabilities.

Range Table - Comprises three columns - Range, Accuracy and Armour Penetration. Range is in 
metres, Accuracy is a decimal where 0.35 = 35% and Armour Penetration is in millimetres of 30 degree 
sloped armour. Use practical ranges, rather than theoretical max ranges. Note that the AI will use this 
table to determine when a unit should fire. It does so by determining the unit’s effective or ambush 
range ( depending on the task setting ). Effective range is that range at which it can achieve an accuracy 
of at least 33%. Ambush range is that range at which it can achieve at least 67%. 
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To enter a new row in the 
range table:

	 Hit the Add button 
and enter the 
values in the three 
text entry fields 
above the table.

To delete a row from the 
table:

	 Select the row and 
hit the Remove 
button.

Armaments Tab

Armaments refers to any sub-weapons belonging to this item. Most weapons will not have any 
armaments of their own and hence the listing will be empty.

To add an armament:

	 Select the desired 
weapon from the 
Weapons tab 
list, drag to the 
Equipment Name 
field and release 
and then set the 
desired quantity.

To delete an armament:

	 Select it from 
the Armaments 
list and set the 
quantity to zero. It 
will be removed the next time you open the data view.
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Vehicles

General Tab

Type - Choose from the drop down 
menu.

Turret - Check if this vehicle has a 
turret.

Open Top - Check if the top of the 
vehicle is open to the air - ie the crew 
are exposed.

Width/Height/Length and Weight - 
the dimensions in metres and weight in 
kilos.

Battle Weight - how much the vehicle 
weights in kilos when fully loaded with 
ammo, fuel and stores.

Picture - The ID of the Estab Image file located within the associated Estab Images folder - see Estab 
Images above.

No Image - Check if there is no image file for this weapon.

Performance Tab

Crew - how many personnel  that 
normally operate the vehicle. Must 
be at least one - ie the driver. Exclude 
passenger troops for motorised and 
mechanised infantry vehicles.

Personnel Capacity -  the number of 
passengers that can be carried ( excluding 
the crew ).

Fuel Capacity - how much fuel in litres 
that the vehicle normally carries in its 
internal fuel tanks.

Bulk Fuel Capacity - how much fuel in 
litres the vehicle carries in external tanks 
or bladders.
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Payload Capacity - how much cargo in kilos the vehicle can carry.

Towing Capacity - how many kilos the vehcile can tow or pull.

Reliability - a percentage measure of how mechanically reliable the vehicle is, where 1.00 = 100%. 
This value will be used for determing vehicle breakdowns, when this modelled in the engine.

Take Cover Mod - the percentage modifier applied to the hit probability when the vehicle is deployed 
( eg hull down ) and being fired at.

Ronsonability - percentage chance of the vehicle catching fire after being hit by direct/indirect fire.

Max Gradient - the maximum slope measured in degrees that the vehicle can traverse

Max Fording Depth - the maximum depth of water measured in metres that the vehicle can traverse

Max Trench Width - the maximum width in metres of any trench or gap that can be traversed.

Speed - comprises two columns ( Normal Speed and Max Speed ) and three rows ( Road, Cross 
Country and Fuel Consumption ). Speed is in kilometers per hour and consumption in litres per hour. 
These are practical rates not theoretical rates.

Armour - the amount of hardened armour plate on the Front, Side, Rear and Top measured in 
millimetres at 30 degree slope. Note that where the vehicle has a turret and a hull these reflect an 
average of the turret and hull armour plate for that aspect. If the slope of armour is not at 30 degrees, 
then this must be converted to its 30 degree equivalent.

Armaments Tab

Armaments refers to any sub-weapons 
belonging to this item. Most weapons 
will not have any armaments of their 
own and hence the listing will be empty.

To add an armament:

	 Select the desired weapon from 
the Weapons tab list, drag to 
the Equipment Name field and 
release and then set the desired 
quantity.

To delete an armament:

	 Select it from the Armaments list 
and set the quantity to zero. It 
will be removed the next time you open the data view.
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Forces
The force tree list is organised hierarchically - side, nation, service, units. 

Side

Insignia - you need to set both a small and large 
insignia image 

Basic Consumption Rate - in kilos per day. Used to 
determine resupply requirements for basic supplies - ie 
food, water and stores. 

Default Enemy APerFP - the default anti personnel 
firepower used by the intel code where it is assumed a 
typical small infantry company would be present.

Default Enemy AArmFP - the default anti armour 
firepower used by the intel code where it is assumed a 
typical small infantry company would be present.

Nation

Insignia - you need to set both a small and large insignia 
image 

Nationality - not used
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Service

General Tab

Insignia - you need to set both a small and 
large insignia image 

Commander Ranks - add as many ranks as 
required. These will be used to seed the Rank 
drop down list in the Unit data view.

Default Icon Tab

Symbol Color - either black or white. Affects 
the colr of the Nato or Picture symbol used 
to depict the type of unit. Use black on light 
coloured backgrounds and white on dark 
backgrounds. 

Background Main Color - the normal 
background color.

Background Dark Color - the shadow 
background color.

Background Light Color - the hilighted 
background color.

Designation Color - the colour of the text 
denoting the unit’s designation.
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Unit

General Tab

Force Type - 
General category 
either infantry, 
armour, artillery 
or logistics.

SubForce Type - 
The options vary 
with the Force 
Type selected. 
Together with 
ForceType, this 
field is used by the 
AI to sort, find or 
select units.

Combat Class - 
either line, line 
support, support, 
HQ, base or 
static.   Line units 
are able to assault 
independent of 
any other force 
types - eg infantry and tank companies. Line Support can assault but only if accompanied by a line unit 
- eg heavy machine gun units, anti-tank units. Support units cannot assault but can provide indirect fire 
- eg artillery, rocket and mortar batteries. HQs are command elements. Bases move and store supplies 
and provide logistical maintenance and support. Static units cannot move - eg garrison infantry and 
fortress arty batteries.

Target Class - either hard, mixed or soft. Used by the AI to determine the type of fire to be used 
against this unit. Hard units are engaged by anti-armour fire power ( AArmFP ) and should be used for 
all armoured fighting vehicles ( AFVs ) where the crew and any passengers stay with the vehicle. Soft 
is engaged by anti-personnel fire power ( APerFP ) and is used for any personnel type units such as 
infantry, engineers, cavalry etc. Mixed is used for those AFVs where the passengers can dismount and 
fight exposed, such as mechanised infantry. When mounted they are engaged with AArmFP and when 
dismounted by both AArmFP and APerFP.

Move Class - either foot, bycycle, horse, halftrack, tracked, wheeled, air, sea or sub. Air Sea and Sub 
are not supported at the moment ( so do not use them ). In effect the remaining classes are converted to 
either motorised ( wheeled, tracked or half-tracked ) or non-motorised ( foot, byclcle, horse ). We aim 
to cater specifically for each class in the future.
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Force Size - either section, platoon, company, battalion, brigade, division, corps, army or army group. 
Note that where units were historically called a regiment, this may be either a battalion or brigade sized 
unit. Eg a British Armoured Regiment is a battalion size while a US Infantry Regiment is a brigade 
size. US Army squads are a section size. Most arty batteries are a company size. German kamphgruppe 
( KGs ) can be of any size. American task forces  ( TFs ) and British battlegroups ( BGs ) are typically 
of battalion size but can be company size.

Commander Rank - choose from the drop down list, which is seeded ranks of the Service this estab 
belongs to.

Personnel - the number of people in the unit.

Staff Capacity - this affects how many units this unit can command efectively. See the Game 
Manual:Staff Capacity and Staff Load for a full explanation. As a rough guide use the following 
ranges: company = 1. Bn HQs = 4 to 6. Bde HQs = 6 to 8, Div HQs = 8 to 12, Corps HQ = 12 to 14, 
Army HQs 15 to 18.

Infanry Value - the number of “bayonets” in the unit - ie the number of personnel who fight as 
infantry. Affects force allocation. In an infantry company this will generally equal the Personnel value. 
In a mech inf, engineer or recon unit it may only be a fraction as AFV and construction vehicle crew 
would be excluded. In an amroured or arty unit it would be zero.

Recon Value - affects force allocation and detection of enemy. As a rough rule of thumb this should 
be 20% of the Personnel value for infantry units, 80% for dedicated recon units, zero for all base, HQ, 
support and line support units.

Engineer Value - affects the time required to build bridges, prepare demolitions and the probability of 
removing demolition charges. As a rough rule of thumb this should equate to 8.33% of the Personnel 
value of engineer units ( ie 1 point for every 12 engineers ) - otherwise zero.

Can Bombard/On-call Support - check if this unit can conduct bombardments and provide on call 
support - ie is an indirect fire unit such as artillery, mortars or rockets.

Reload Time - only enter a value ( in hours:minutes ) if this is an indirect fire unit that must spend 
significant time reloading after firing. Usually applies to rocket launchers, where each barrel must be 
reloaded manually. Not normally set for mortars or artillery. 

Deployment Duration - the time ( days:hours:minutes ) it takes the unit to deploy ( ie to find good 
firing positions ), dig-in ( ie to dig open trenches ), entrench ( ie to dig trenches with overhead protection 
) or fortify ( ie enter a pre-esiting fortification ). Note that units cannot build fortifications during a 
scenario, so the value for fortifications is not used ( but leave as the default “1:00:00”). Most infantry 
units can deploy in around 5 minutes. Hvy weapons take longer: light/mdm mortars and AT guns - 7 
to 10, field howitzers - 20, heavy guns - 30. Most infantry can dig in in 2 hours and be entrenched in 
2 days.

Speed - the practical speed in kilometres per hour ( kph ) at Normal and Max rates of movement along 
a highway. Most foot units move at 6/9 kph ( normal/max ). Most wheeled support units at 20/30 kph; 
armour at 38/50. Armoured car and recon at 40/60.
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Equipment/Supply Tab

Basics Consumption Rate -  a percentage modifier to the side’s Basics Consumption Rate where 1.0 
= 100% or no effect and 0.1 = 10% of the side rate. In general leave most units at 1.0. Logistics units 
like Bases can be set to 1.5.

Fuel Load - the number of hours of fuel the unit is normally supplied with. The default is 12.

Equipment List - drag the desired weapon or vehicle to add them to the list. Select and enter the 
quantity. Avoid adding additional weapons to a unit where your source may be incorporating those 
weapons that are part of vehicles.



ESTAB EDITOR MANUAL

28
Copyright Panther Games Pty Ltd 2015. All Rights Reserved.

Icon Tab

Symbol Color - either black or white. Affects the colr of the Nato or Picture symbol used to depict the 
type of unit. Use black on light coloured backgrounds and white on dark backgrounds. 

Military Symbol - choose the desired NATO symbol from the drop down list.

Picture Symbol - choose the desired picture symbol from the drop down list.

Force Size Icon - choose the desired size icon from the drop down list.

Background Main Color - the normal background color.

Background Dark Color - the shadow background color.

Background Light Color - the hilighted background color.

Designation Color - the colour of the text denoting the unit’s designation.
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Formations
Moving Cohesion Level - the cohesion level the 
unit gravitates to as it moves in this formation. 
Columns maintain good cohesion on the move 
while lines and squares do not.

Frontage - the amount of frontage each man covers 
in this formation. Total frontage = frontage per man 
x persQty.

Depth - the amount of depth each man covers in this 
formation. Total depth = depth per man x persQty.

Aspect Modifiers - there are four aspects - front, 
rear, left and right. Each has three modifiers.

Target Percentage - how much of the units 
personnel and equipment are exposed to fire 
through this aspect.

Firing Percentage - how much of the units weapons 
can fire from this aspect.

Security - how secure this aspect is ( either min, normal or max ). This is used in the code that 
determines which formation to use. If security is a concern and the enemy threat is to the left then the 
code will be more likely to select a formation with a high security rating for the left aspect - eg Left 
Echelon.
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Compiling and Testing
Once you have finished entering the data:

	 Save the .xml file

	 Close all data windows ( recommended )

	 Select Compile Estab File from the Build menu 

This will open a warning message advising 
you that you should have saved the Estab.xml 
file prior to compiling. If you haven’t simply 
select No, save the file and then repeat. It also 
warns that any opened data view will be saved 
prior to compiling. 

	 Hit Yes to continue or No to abort.

The compiler Output pane then appears at the bottom of the screen and the output text appears advising 
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the steps taken. Note that it should end with the line “Saving estab file to.....coe”. If this doesn’t occur, 
then it should advise an error message. This may be that an image is missing or some data has been 
entered incorrectly. Deal with it and repeat.

Make sure you either save or move the compiled Estab.coe file into the Estabs directory of the game 
before testing. 

	 Link the estab file to the scenario files.

You will need to ensure that the scenario you intend testing your estab file on has been linked to the 
estab file. To do so, please refer to the ScenMaker Manual. Once linked/set, you will not need to repeat 
this step.

	 Test.

The best way to test the estabs is to open the game and run a scenario that uses the estab file. Check 
the estab data displays and ensure that the game runs without error. If there is anything missing or 
incorrect, then the initialisation checks may fire on loading the scenario and advise you of an error. 
Note down any estab details mentioned in the assert. You can then load the xml version in a text editor, 
find the estab item referred to by searching for its ID and note its name and details. Then go back into 
the Estab Editor to amend it.
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Annex A - Estab Editor Checklist

	 Clone the CO Estab.xml file

	 	open the CO Estab.xml file

	 	save it under a different name in the Game’s Estabs dirctory

	 	save a copy of the CO Estab_Images directory under a different name

	 Research your facts - use quality source references

	 Enter the Data

	 Save Early, Save Often

	 Close all Data windows ( recommended )

	 Compile the Estab.coe file

	 Link the Estab to Scenarios

	 	open the ScenMaker and set the Estab file for the desired scenario(s)

	 Test

	 	open the Game

	 	run the scenario

	 	note any error asserts on loading

	 	check the Estab data views

	 	make sure the game runs
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